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ALPHA – User Guide 
 

 
 
 
 
 

 
 
 
 
 
 

 

  

WARNING 
To reduce the risk of injury, before using or servicing tool, read and understand 
the following information. 
The features and descriptions of our products are subject to change without 
prior notice. 
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Revision history 
 

Issue Date Description 
Firmware 
version 

Minimum 
DeltaQC 
version 

01 10 January 2012 First issue. 1.0x 2.0.x 

02 28 August 2012 Curves added. 1.0x 2.1.x 

03 
14 November 

2012 

DeltaQC installation updated, 
overload management updated, 
transducer information and report 
added, default values updated. 

1.2x 2.2.x 

04 16 May 2013 Settings updated (par.10). 1.3x 2.4.x 

05 16 April 2014 Battery added 2.0x 2.5.x 

06 4 December 2014 Manual update 2.0x 2.5.x 

07 29 May 2015 Manual update 2.1x 3.2.x 

08 
15 September 

2015 
General User Guide review, Cutoff 
frequency (Fcut) added (par. 8.1.5) 

2.2x 3.2.x 

09 13 May 2016 

Specifications – System 
requirements updated (par. 1.2), 
Presentation updated (par. 2.1), 
Software installation updated (par. 
4.1) 

2.2x 3.5.x 

10 29 June 2018 
Software Installation updated (par. 
4.1), Menu list updated (par. 4.2.1), 
Database backup added (par. 4.5) 

2.2x 4.0.x 

11 30 October 2018 

Alpha transducer information updated 
(par. 0), Language updated (par. 
10.1), Date – time updated (par. 
10.2), Alpha name updated (par. 
10.4), Result confirmation option 
updated (par. 10.5) 

2.2x 4.1.x 

12 
19 September 

2022 
Specifications: Torque range correction 2.2x 4.1.x 

13 6 February 2023 
Online mode added (par. 4.2.4), 
Transfer online data to the database 
added (par. 4.2.4.1) 

2.2x 4.3.36 

 

NOTE: The programming software DeltaQC may be updated with no changes regarding the 
Alpha functionalities.  
The minimum version indicated here is required for the reference firmware version.  
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SAFETY INFORMATION 
 
 

 

WARNING: PLEASE CAREFULLY READ THE ALPHA SAFETY INFORMATION (No. 
6159920600) PRIOR TO USE THE PRODUCT AND PAY ATTENTION TO THE SAFETY 
INSTRUCTIONS PROVIDED. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Part Number 
Issue  
Date 
Page 

6159938890 
13 
02/2023 
6 / 96 

 

02/2023  6 (96) 

BATTERY INFORMATION ACCORDING TO EUROPEAN  
REGULATION 2006/66/EC 

 

 
BATTERY SPECIFICATION 

 
TYPE:    Lithium-ion, 3.6 V, 2.9 Ah 
CELL WEIGHT: 50 g 
 

 

 
The battery is installed inside the Alpha (refer to the picture below):  

 
 

 
                       
 

 

NOTE: Once removed, the wasted batteries must be dismissed according to local 
regulations. 

 
 
 

 
 
 
 
 
 
 

Battery 
sample 

Remove the cover 
of the Alpha Extract the 

battery 
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1 INTRODUCTION 

1.1 About this Document 

This document is a User Guide for the Alpha.  

The Alpha is described in general in the first two chapters of this User Guide. 

The document is divided into the main following parts: 

Part Name  Description 

Chapter 1 Introduction  
This part introduces this user manual and details 
the Alpha technical specifications. 

Chapter 2 System Overview 
This part introduces the Alpha with its models and 
accessories.  

Chapter 3 User Interfaces 
This part provides an overview of the user 
interfaces available on the Alpha (LEDs, display, 
keyboard, etc.). 

Chapter 4 Working with DeltaQC 
This part introduces the operations of the Alpha 
management software.  

Chapter 5 Getting started with Alpha 
This part guides the operator in starting to use the 
Alpha. 

Chapters 6, 
7, 8 and 9 

Testing click-wrenches, 
testing nutrunners, peak 
detection test, testing pulse 
tools 

These chapters explain in detail how to conduct a 
test on the various tools types. 

Chapter 10 Alpha settings This part covers the instrument settings. 

Chapters 
11 and 12 

Results viewer and Curves 
viewer 

These chapters explain how to retrieve results 
and curves from the Alpha. 

Chapters 
13 and 14 

Maintenance and 
Troubleshooting guide 

These chapters are dedicated to the instrument 
maintenance and troubleshooting 

Chapter 15 Abbreviations Table of the abbreviation used in this manual. 
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1.2 Specifications 

TECHNICAL 
 

• Torque range: Alpha D1   : 0.1 ÷ 1 Nm 

Alpha D5   : 0.5 ÷ 5 Nm 

Alpha D16 : 1.6 ÷ 16 Nm 

• Torque static accuracy: ±1% of the applied torque (between 10% and 100% of 
the FSD) 

• Torque overload capacity: 25% of FSD 

• Stability of zero offset with temperature: ± 0.1% of FSD/ºC 

• Results memory capacity:  1000 

• Curves memory capacity: 10 curves (30 sec / maximum length) 

• Unit of measurement supported: N∙m, kgf∙m, kgf∙cm, lbf∙ft, lbf∙in, ozf∙ft, ozf∙in, kp∙m, 
dN∙m 

• Sampling frequency: - Free mode (track and peak):            1 kHz 

- Click-wrench test:       2 kHz 

- Nutrunner test:       4 kHz 

- Peak test:       1 kHz 

- Pulse tool test:       4 kHz 

 
INTERNAL BATTERY  
 

• Battery power supply: Rechargeable battery, Li-ion 3.6 V 2.9 Ah 

• Endurance: 12 hours minimum in operating mode  

• Recharge time: 4 hours (the battery is charged even if the Alpha is switched off) 

 
NOTE: The battery is internal and cannot be removed. The external power supply works also 
as battery charger. 
 

 
EXTERNAL POWER SUPPLY 
 

• Input power: 100 ÷ 240 V AC, 50 ÷ 60 Hz 

• AC Power Consumption: 21 W maximum 

• Output: 6V DC, max 2.2A 
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DIMENSIONS AND WEIGHT 

 
 

Dimensions are in mm 

Weight: 950 g 
 
NOTE: Alpha D1 / D5 / D16 are characterized by the same dimensions and weight.  They differ 
only for the Torque range. 
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ENVIRONMENTAL 
 
The following conditions must be observed during operation: 

• Internal Use only 

• Environmental Class: II 

• IP Grade according to EN IEC 60529: IP40  

• Ambient Temperature: 5 to 40°C 

• Atmospheric humidity: 95% (non-condensing) 

• Altitude: up to 2000m 

 
 
INTERFACES 
 

• MiniUSB 2.0 port 
 
 
SYSTEM REQUIREMENTS 
 
The following are the PC minimum requirements for installation of the management software 
DeltaQC: 

• Processor: 800 MHz or above  

• Memory: 256 MB or above 

• Hard disk space: 10 GB 

• Display: 800 x 600, 256 colors (1024 x 768, High Color (16-bit) recommended) 

• Operating Systems: Windows XP, Windows 7, Windows 8, Windows 8.1, Windows 10 

• Internet Explorer 5.01 or later (required for installation of the .NET Framework) 

• Windows Installer 3.1 

• Microsoft Excel (required to view the exported file with the tightening results) 

 
NOTE: A system should meet these or the minimum requirements for the operating system, 
whichever is higher. 

 
   
CALIBRATION CERTIFICATE 
 
Alpha is provided with a Desoutter factory calibration certificate. 
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1.3 EC Declaration of Conformity 

The Alpha is in conformity with the requirements of the council Directives on 06/22/1998 on the 
approximation of the laws of the Member States relating: 
 

• 2004/108/EC  EMC Directive – Electromagnetic Compatibility 

• 2011/65/EC ROHS Directive – Risk Of Hazardous Substances 

 
The Alpha complies with the following regulation: 

• EN61010-1:2010   Safety Requirements for Electrical Equipment for Measurement, 
Control and Laboratory Use – Part 1: General Requirements. 

 

The Alpha is marked with the following symbol: 
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2 ALPHA OVERVIEW 

 

 

 

 

Alpha D1 / D5 / D16 are instruments designed for optimal 
operations in: 

• Tools testing: The Alpha offers a set of tests for evaluating 
click-wrenches, slip-wrenches, nutrunners and pulse tools, 
measuring the torque values and producing results with 
statistical parameters. This makes possible to keep the 
quality of the tightening operations on a production line 
under control. The test results can be retrieved by the Alpha 
management software (DeltaQC), and exported then in an 
Excel file.  

 

 

 

 

 
NOTE: The caption “D1, D5 and D16” indicates the maximum instrument torque capacity: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• D1 → 1 Nm 

• D5 → 5 Nm 

• D16 → 16 Nm 



 Part Number 
Issue  
Date 
Page 

6159938890 
13 
02/2023 
13 / 96 

 

13 (96)  02/2023 

2.1 Presentation 

The Alpha is composed by the following parts: 
 

 

Alpha D1 / D5 / D16 
 

The main part that contains the hardware, 
firmware and battery. 

 

 
Power Supply/Battery Charger 

 
External power supply for battery recharge. 

 

                

DeltaQC software 
 

The Alpha management software. It allows 
Alpha configuration and retrieving results 

and curves from the instrument. 

 

        
                  

 

Mechanical joint simulators 
 

Two joint simulators are provided with the 
Alpha: one to simulate a soft joint and one a 

hard joint. 

 
 

 

Supports 
 

The supports are useful to fix the Alpha to a 
table. The screws are included with the 

package. 

 
 
 

Soft 

Hard 
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2.2 Models 

 

 
 
The Alpha models available are listed in the following table: 
 
 

• Alpha D1 P/N 6159351400 

• Alpha D5 P/N 6159351410 

• Alpha D16 P/N 6159351420 

Transducer 

Display 

Buzzer 

Keyboard 

Alpha model 

Support to fix the unit to a table 

Mini USB 

Power supply connector 

Support to fix the 
unit to a table 
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3 USER INTERFACES 

3.1 Display 

The Alpha display explores the menus and monitores the torque during the tightening operation: 

 
 

Test type It indicates the test type.  

Battery charge 
status 

It indicates the battery charge level. 

Tightening 
directions 

It indicates whether tightening must be executed in the clockwise or 
counterclockwise direction. 

Torque It indicates the current measurements.  

Statistics 
 

It indicates the minimum and maximum and average values, and 
standard deviation.  
For the pulse tools, also the frequency of the pulses is shown. 
They are reset when exit the test window.  

 
The display background color changes according to the tightening phase and result: 
 

White Default color for all the menus and settings. 

Blue When a test starts, the display is backlight in blue. 

Green During the test execution, the display turns green when the result is OK. 

Red Color used to indicate error. 
During the test execution, the red color is used to indicate that torque 
value exceeds the maximum limit. 

 
NOTE: For better printing contrast, and for black/white printing, in this User Guide the display 
figures are always shown in black/white.  

Test type 

Torque 

Tightening direction 

Battery charge status 

Statistic
s 
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3.2 Keyboard 

Use the keyboard to browse the Alpha menu: 
 
 
 
 
 

 

 

 

3.3 Transducer  
 

     

 
 
The Alpha is characterized by a torque static 
transducer installed on the unit. Simply select 
the test menu on the display and operate the 
tool on the transducer. 
 
The transducer maximum capacity is: 
 

 
 
 
 
 

 
 

 
 
 
 
 
 
 

Icon Name Description 

 
ON, OK 

 
Switch on the Alpha, enter menu and confirm. 
 

 
OFF, CL Switch off the Alpha, exit menu. 

 
UP 

Up (browse menu),  increase value in settings 
menus. 

 
DOWN 

Down (browse menu), decrease value in 
settings menus. 

• Alpha D1 → 1 Nm 

• Alpha D5 → 5 Nm 

• Alpha D16 → 16 Nm 

Transducer 
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The transducer data can be viewed/set from the menu.  
Switch on the Alpha by pressing the ON button. 
Scroll the main menu using the Up/Down keys and select the Transducer Info menu: 

 

    
Min load (%) and Overload (%) are editable parameters. To edit them, press the OK button on the 
parameter to change, adjust the value by pressing the Up/Down keys, and click on OK to save (or CL 
to exit). 
 

Capacity (Nm) Torque capacity of the Alpha, that is normally slightly different from the 
nominal capacity marked on the Alpha label. 

This value cannot be modified. 

Min Load (%) Minimum torque value for the Cycle start parameter set for the various 
tests, defined in the Measurement Setup menus (refer to the paragraph 
“Getting started with Alpha” or further details). 

It can be set from 1% to 5%. 

Overload (%) This parameter specifies the maximum torque applicable to the 
transducer as percentage of the Capacity value. 

It can be set from 90% to 125%. 
 

If the torque goes over the overload value, a warning message on the 
Alpha display alerts the user, and it is shown again each time the Alpha 
is switched on; to reset the overload event, the Alpha must be 
recalibrated. 

 

Information and report about the Alpha transducer can be viewed from the DeltaQC software (refer to 
the “Working with “Delta QC” Software” for software installation and usage details).  
 

Connect the DeltaQC to the Alpha and select the Connected transducer in the Assembly Line area: 

Transducer info 
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The Min Torque is calculated by multiplying the Nominal torque and the Min Load (%) set in the 
Alpha (as explained above).  
The Overload torque is calculated by multiplying the Nominal torque and the Overload (%) set in 
the Alpha (as explained above).   
 
By selecting the Report page it is possible to view the report (refer to the screen below): 
 

 
The toolbar placed in the area above the report provides function to print or export the report into an 
Excel or PDF file. 

3.4 Buzzer   

Along with the onboard LEDs, the Alpha has also a buzzer, to give more indications on the result of 
the current operation. A high tone is emitted in case of OK result, while a lower tone is emitted in case 
of test Not OK.  

 
NOTE: For further details, refer to the specific chapters for various tests available on the 
Alpha. 
 

 
 
 
 

Toolbar 
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3.5 Mini USB port 

  
 

 
 
 
The USB port is available for programming the 
Alpha by means of DeltaQC Software. 
 

NOTE: Refer to the paragraph 
“Connecting to the Alpha” for further 
details. 

 
It allows also firmware upgrade (this feature is 
reserved for Desoutter Service Personnel).  
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

USB port 



 Part Number 
Issue  
Date 
Page 

6159938890 
13 
02/2023 
20 / 96 

 

02/2023  20 (96) 

4 WORKING WITH “DELTA QC” SOFTWARE 

 

 
 
DeltaQC is a PC software package developed to manage the Alpha. 

It offers easy user-friendly programming and real time monitoring of the instrument. 

DeltaQC serves as an interface between the user and the Alpha. With DeltaQC, users can configure 
the Alpha, and receives the results and curves.  

The main features that characterize the interaction between DeltaQC and Alpha are as follows: 

• Review of results from the Alpha 

• Review of curves from the Alpha 

• Settings of the Alpha 
 

 
NOTE: DeltaQC saves the tightening programs, results and curves in a local database. 

 

4.1 Software Installation 

 

NOTE: Do not install the software from a shared folder/drive. Install the software from the 
supplied CD/USB key; if the CD/USB key content is copied into a PC folder, it must be a PC 
local folder. 

 

NOTE: If a version equal to 3.9.0 (or previous) is upgraded to a version equal to 4.0.0 (or 
later), it is recommended to perform the migration of data from SQL Server database to SQLite 
database before launching DeltaQC. 

 

NOTE: Make sure to read the Installation Instructions contained in the ReadMe file before 
starting DeltaQC installation. 

 
 
 
 
 
 

Excel 
File 

 

Printer 
DeltaQC 

Alpha 

USB or 
Network 
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If DeltaQC is already installed on the PC and it is characterized by a version equal to 3.9.0 (or 
previous), it is MANDATORY to uninstall it BEFORE executing the new setup. 
 
To uninstall previous versions, act on the control panel as explained in the following procedure: 

• Open the “Control Panel” and click on “Programs”:  

 

 

The following screen is shown: 
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• To uninstall (or change) programs on the PC, click on “Programs and Features” (refer to the 
above screen). The following screen is displayed: 

 

 
 

Select “DeltaQC” from the list. Click on the right button of the mouse and finally select “Uninstall” 
in order to uninstall DeltaQC from the PC. 
 

• After clicking on “Uninstall”, the following pop-up is shown: 
 

 
 
Click on Yes to confirm uninstalling the DeltaQC. 
 

• After clicking on Yes (refer to the above pop-up), Windows Installer is preparing to remove 
DeltaQC. The following pop-up are shown until DeltaQC is completely removed: 
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If DeltaQC is either not installed, or already installed on the PC and it is characterized by a version 
equal to 4.0.0 (or higher), execute the new setup.  
 

 
To install DeltaQC Software, insert either the CD or the USB key in the PC. 
 
If the CD is inserted in the PC, the following pop-up is shown (according to Autoplay Settings set on 
the PC):  
 

 
 
Click on “Run DesoutterAutorun.vbs” and wait for the following window: 
 

 
 

 

NOTE: For the operating systems Windows 7, Windows 8, Windows 8.1 and Windows 10, 
run the executable file by clicking on the right button of the mouse and selecting “Run as 
administrator”. 
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If a USB key (refer to the figure on the right) is inserted in the PC, 
the following pop-up is shown (according to Autoplay Settings set 
on the PC): 
 

 
Double-click on “Open folder to view files”. The following folder is shown: 
 

 
 
Double-click on “DesoutterAutorun.vbs” and wait for the following window: 
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Install DeltaQC Software  
 
Firstly, click and read the ReadMe file containing information about 
the installation. 
 
Then, click on the button Install Driver (ADMIN) to start the device 
driver installation. 
 
Click on the Install Software button to start DeltaQC installation. 
 
Finally, click on the DB Migration button to start the database 
migration. 

View User Manual  

 
 
Open the “Alpha User Guide” in PDF. 

Contact Us 

 
 
It provides the website link to Desoutter contact details. 
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 Register DeltaQC Software 

 
 
It provides the website link to register the DeltaQC Software.  

Registration must be executed after the installation.  

Refer to the paragraph “Software registration” for further details. 

 
To start the device driver installation, click on the Install Driver (ADMIN) button and follow the steps 
described below:  
 

 

 

 

Click on the Install button (refer to the figures below): 

 

At the end of the process a message confirms that the device driver are installed with success. 
  
 
 

 

NOTE: If the device driver installation is executed on a PC without administrator rights, a 
dialog box for the “User Account Control” opens.  
Enter the administrator username and password in the related fields to continue.  
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To install DeltaQC Software, click on the button Install Software (refer to the following figures): 
 

 
 
Then, follow the installation steps described below: 
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After installing DeltaQC Software, the program is automatically added to Start Menu → Desoutter → 
DeltaQC and to Start Menu → Control Panel → DeltaQC. 

If not deselected during the installation procedure, a Desktop shortcut will be created by default too. 
 

 

NOTE: The first time DeltaQC Software is executed, it is MANDATORY to register it (refer to 
the paragraph “Software registration” for further details). 
  

 
If a version equal to 3.9.0 (or previous) is upgraded to a version equal to 4.0.0 (or later), it is 
recommended to perform the migration of saved data from SQL Server database to SQLite database. 
 

 
To start the database migration, click on the button DB Migration (refer to the following figures): 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

NOTE: If the database migration is not performed before launching DeltaQC, data possibly 
present in the new database are deleted. 
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The following windows are shown: 
 

 
 
Click on Start to execute the database migration (the operation may take a few minutes, depending 
on the size of the database).  
Click on Hide Log to hide the Database Migration Tool – Log viewer window. 
 
At the end of the process, the message “Migration completed with success!” is shown (refer to the 
figure below): 
 

 
 

Click on Save Log to save the log before closing, otherwise click on Close. 
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4.1.1 Software registration 

The first time DeltaQC Software is executed, the following window is shown: 
 

 
Click on Continue in demo mode to skip the registration and working in demo mode (the registration 
can be done later). 
 
To proceed with the registration, take note of the Public KEY given in the form above, and click on 
the link www.desouttertools.com/licensing    
 
The following window is shown: 
 

 
 
 

Login or create a 
new account 

Public KEY 

Click to register 

Registration 
instructions 

Continue in 
demo mode 

http://www.desouttertools.com/licensing
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Create a new account, if it is not created yet: 
 

 
 
Enter the own information and click on Submit. The following confirmation message is shown: 

 
On the email address given in the account above, a link is sent. Click on the link provided. 

 
 
 
 
 
 
 
 

Submit 

Click on “home” to login 
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Click on “home”; now it is possible to login: 

 
 

 
On the following window, select License Management (from the same window it is possible either to 
edit the profile information or to open the Desoutter contact form): 

 
Enter the Serial number and the Key (License number) provided on the installation CD: 

Login 

License 
management 

Edit profile 
Contact 

Desoutter 

Serial number written on the CD 

Key (License number) written on the CD 
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Click on Submit and the following window is shown: 

 
Click either on Add to proceed with the registration or on Delete to delete the serial number and key 
already entered. 
 
After clicking on Add, the following screen is shown: 

 

 
 

Add 

PC name 
Public key 
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Enter the Public key generated by the DeltaQC Software registration form and the PC name (choose 
any name) and click on Submit to get the registration code: 

 
Copy the above Registration code in the DeltaQC registration form and click on “Register” to 
complete the registration: 

 

Registration code 

Enter the Registration 
code 

Click on Register 
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4.1.2 DeltaQC “Evaluation version” 

If DeltaQC Software is not registered after the installation, it works as Evaluation for 90 days; the 
Evaluation version provides all the functionalities of the registered version. When the trial period 
expires, the software turns into Free version.  
The number of days that remain for the trial period is shown on the bottom part of the DeltaQC 
Software page (refer to the picture below): 
 

 
 
 

4.1.3 DeltaQC “Free version” 

When the trial period expires, the software turns from “Demo” into “Free” version.  
 
The Free version has a limited set of function. It is possible only to define tightening programs (Pset), 
review the results from the Alpha (exporting them in an Excel file) and define the settings of the 
instrument; all the other features are not available. 
 

 
 

Evaluation 
days remaining 

Results Viewer 

Controller settings 
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4.1.4 DeltaQC Licensed and Advanced versions 

It is possible to register DeltaQC Software in two different versions: Licensed or Advanced. 

The Advanced version, compared to the Licensed version, can save the results and curves on the 
database; on the Licensed versions the results and curves can be viewed online only when the 
software is connected to the Alpha. 

4.1.5 DeltaQC software upgrade 

In case a new version of the DeltaQC Software is available, the new installation wizard automatically 
overwrites and upgrades the previous one. 

In case of the new version features a new database structure, the first time the new version is 
launched a database migration wizard is automatically started.  

Click on Start and wait until the process is completed: 

 

Ensure that the message “Migration completed with success!” is shown in the window above; then 
click on Close. 

 
 
 
 
 
 
 
 
 
 
 

Click on Start 

Wait until the process 
is completed 
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4.2 DeltaQC Overview 

  

Click on the DeltaQC icon to launch the software. 

 
The following main menu is shown: 
 

 
Once DeltaQC software works by means of the Alpha, only few commands are available: 
 

• Alpha settings (settable by clicking on the arrow close to the Controller icon) 

• Results viewer (settable by clicking on the Results viewer icon) 

• Curves viewer (settable by clicking on the Curves viewer icon) 

 
 
 
 
 
 
 
 

Status bar 

Alpha information 

Log area 

Build area is not 
used for the Alpha 

Toolbar 
Menu list 
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The areas shown in the main menu (refer to the above picture) can be customized; select View to 
define which areas enable or disable: 

 
 
The areas listed in “View” are as follow: 
  

Build area Enable/disable the Build area. It is not used for the Alpha. 

Tree Enable/disable the Assembly line area. 

Details Enable/disable the Assembly line details area. It details the items selected in 
the Assembly line area.  

Log area Enable/disable the Log area that lists the list of the log messages. 

All  Enable/disable all the possible items in the main menu. 

Restore default 
layout  

Restore the default layout that enables all the items except the Log area. 

 

To hide one area directly from the main menu, click on the  icon (refer to the picture below): 
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4.2.1 Menu list 

The following options are available in the DeltaQC Menu list: 
 

Illustration Name Description 

 

File The File option allows to: 

- create and restore a database backup file (see 
paragraph “Database backup”). 

- exit from the DeltaQC software. 

 

View The View option selects the areas to show/hide in 
the main menu. 

 

Transfer The Transfer option is not used for the Alpha. 

 

Options The Options tab sets the DeltaQC language and 
enables/disables the log file. Furthermore, a list of 
available devices can be viewed. 

 

Service The Service option allows to register the software. 

 

About The About tab gives software information, including 
registration details. 
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4.2.2 Toolbar 

The toolbar icons are shortcuts to the basic functions in DeltaQC. 
 

Icon Icon name Description 

 

Save This icon is not applicable for the Alpha operations. 

 

Undo This icon is not applicable for the Alpha operations. 

 

Transfer PC 
→ Device 

This icon is not applicable for the Alpha operations. 

 

Transfer 
Device → PC 

This icon is not applicable for the Alpha operations. 

 

Controller Click on the arrow of this icon to open the Controller programming menu. 
Controller icon contains information and settings for Alpha. 
 
Refer to the paragraph “Alpha Settings” for further details. 

 

Bench 
programming 

This icon is reserved for the use of the DeltaQC with the Delta Cart; thus it 
is not used for the Alpha. 

 

Results 
Viewer 

This icon opens the Results Viewer page. 
 
Refer to the paragraph “Results Viewer” for further details. 

 

Curves 
Viewer 

This icon opens the Curves Viewer page. 
 
Refer to the paragraph “Curves Viewer” for further details. 

 

Statistics This icon is not applicable for the Alpha operations. 

 

Connect This icon establishes the connection between the Alpha and the PC (the 
icon is disabled when the device is already connected).  
 
Refer to the paragraph “Connecting to the Alpha” for further details. 

 

Disconnect Once a connection is established, this icon gets active. Click to disconnect 
the PC from the Alpha. 

 

Help This icon opens the Help section (not active in this software version).  

 

 



 Part Number 
Issue  
Date 
Page 

6159938890 
13 
02/2023 
41 / 96 

 

41 (96)  02/2023 

4.2.3 Status bar  

The status bar shows the connection status between the Alpha and the DeltaQC.  
 

 

4.2.4 Online mode 

 
NOTE: The DeltacQC Online mode is active only when an Alpha is connected to the PC. 

4.2.4.1 Transfer online data to the database 

Results and curves defined online can be saved in the local database file by selecting Transfer → 
Device ---> PC in the toolbar of the main DeltaQC screen: 

On the dialog box, select the items (Results and/or Curves) to be transferred from the Alpha to the 
local database (on the PC) and click Save to confirm.  
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4.3 Alpha transducer information 

In the Transducer → Connected transducer menu it is possible to view the details of the Alpha 
transducers: 

 
 
The following data are available in the above Information page: 
 

Serial number Transducer serial number (in general different from the Alpha serial number). 

Type Alpha type.   

Nominal torque This value is the capacity value written on the Alpha. Generally, it differs 
slightly from the real capacity of the Alpha (specified in the Max. Torque). 

Min. Torque Minimum load of the Alpha, that is equal to the 1% of the Max torque. 

Max. Torque  Torque capacity of the Alpha. 

Overload torque  Maximum torque applicable to the Alpha without producing damages. 

Last overload Date, time, and value of the last torque overload detected by the connected 
transducer. This option is not available for the Alpha. 

Sensitivity Sensitivity value of the torque transducer. 

Angular resolution This option is not available for the Alpha. 

Sensitivity torque This option is not available for the Alpha. 
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In the Report area it is possible to see and print a report: 

  
The toolbar in the upper area of the Report provides functions to print the report, or export it in Excel 
or PDF file. 

4.4 Settings in DeltaQC 

It is possible to set the language from the Options → Change language menu:  

Export the Report in 
Excel or PDF file 
 

Transducer 
Report 
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NOTE: After changing the language, restart the software to make the change effective. 

4.5 Database backup 

From the File tab it is possible to create and restore a database backup.  

 
 

To create a database backup file, click on the tab File → Database → Create a backup. 
From the dialog box that opens (see the figure below):  

1. Click on the Folder button to select the destination folder. 
2. Click on the Create button. 
 

 
 
At the end of the process, a confirmation message informs that the database backup file is created 
with success. 
To restore a database backup, click on the tab File → Database → Restore a backup. 
From the dialog box that opens (see the figure below): 
 

1. Click on the Database file button to select the database to import.  
2. Click on the Restore button. 
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At the end of the process, a confirmation message informs that the database backup file is restored 
with success. 
 

 
 
 
 
 

NOTE: If the database to restore is characterized 
by a version higher than the destination 
database, it is marked in red and it is not 
possible to restore it (see the figure on the right): 

 
 
 
 
Upgrade DeltaQC Software to the latest version in order to complete the operation.  
For further information, refer to the paragraph “DeltaQC software upgrade”. 

 
 
 
 

NOTE: If the database to restore is characterized 
by a version lower than the database current 
version, it is marked in yellow (see the figure on 
the right):  

 
 

 

Click on the Restore button, and then on Yes in the dialog box that opens.  

From the DeltaQC - Database Migration window, click on Start to execute the database 
migration and wait until the process is completed.   

The operation may take a few minutes, depending on the size of the database; a green 
progress bar indicates the status of the operation.  

At the end of the process, the message “Migration completed with success!” is shown in 
the window. 

 
 

4.6 Connecting to the Alpha 

The connection between the DeltaQC and the Alpha is performed via USB cable. 
After connecting the Alpha to the PC with the DeltaQC software for the first time, select Scan (refer to 
the screen below): 
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After selecting Scan, the following screen is shown: 
 

 
 
 
 
 
 
 
 
 
After clicking on Scan, select the available Alpha from the list; then click on Select: 

Scan 
 

Click on Scan 
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NOTE: This operation is necessary only once.  

 
 
After the first time, perform the following steps: 

• Launch the DeltaQC software. 

• Turn on the Alpha and wait for its startup (the main menu is shown on the display). 

• Connect the Alpha to the PC through USB cable (with the Alpha already turned on). 

• Click on the arrow of the Connect icon placed on the main toolbar and select USB to establishes 
the connection between the Alpha and the PC: 

 

1. Select the Alpha 
 

2. Click on Select 
 

2. Select USB 
 

1. Click on the arrow 
of the Connect icon  
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NOTE: To establish the connection between the Alpha and the PC, it is also possible to right-
click on USB icon in the Assembly Line area (refer to the screen below): 

 
When the Alpha is connected, the Connect icon is disabled and the Disconnect icon is active: 
 

 
 
 

1. Right-click on USB icon 
 

2. Select USB 
 

Online mode 

Disconnect icon 
 

Online mode 
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4.7 Alpha LOG Viewer 

The Log viewer function allows to obtain information about the Alpha – DeltaQC communication. 
However, this function is more helpful when working with devices that create tightening programs 
from the software and transfer them to the online device. 
 

To enable the Log area click on “Log area” command placed in View option of the toolbar (refer to the 
paragraph “Menu list” for further details): 

 
The messages related to Alpha – DeltaQC communication are displayed in the log area:  

  
A “Log file” is automatically created in a subfolder of the installation directory of the DeltaQC (typically: 
C:\Program Files\Desoutter\DeltaQC\Log). 

 
NOTE: A new file is created each day the software is used; the old files can be deleted. 
 

 

 

NOTE: The “Log file(s)” option can be enabled or disabled in 
the menu Options → Enable log file. 

 

Enable Log area 

Log area 
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5 GETTING STARTED WITH ALPHA 

The Alpha is powered by the internal battery.  
 
NOTE: Connect the external power supply when the battery level is low. 
 

To turn on the Alpha, press the ON button placed on the Alpha keyboard; to turn it off, press the OFF 
button (even placed on the Alpha keyboard) and hold it down for few seconds. The power on screen 
is shown for few seconds, followed by the torque zero adjustment. Thus, the firmware version is 
displayed: 
 

              
NOTE: Do not apply any torque to the transducer during the power on phase, due to the fact 
that the instrument needs to execute a zero procedure for proper operations. 
 

After the power on sequence, the main menu is shown on the display: 

 

• Demo Mode This option enters the demo mode (Track and Peak functions). 

• Measurement This menu manages a test on a tool. 

• Measurement 
Setup 

This option defines the setup parameters for the click-wrenches test, 
nutrunners test, pulse tools and peak test. 

• Settings This menu customizes the Alpha settings. 

• Transducer Info This option gives information about the Alpha capacity, minimum 
load and overload capacity. The minimum load and the overload 
value can be set from this menu. 

 
 
NOTE: After 90 seconds of inactivity, the Alpha enters the Power Save Mode, reducing the 
display brightness. Press any button on the keyboard to exit the Power Save Mode.  
 

 
 
 

Power on screen 

Firmware 
version 

 

Torque zero adjustment 

Main menu 
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5.1 Executing a Demo Test 

The Demo Mode executes a test (track or peak mode) by accessing the Alpha from the keyboard 
without the need to set the test. 

 
NOTE: In this mode the results are not saved in the Alpha memory.  
 

To execute a Demo Test, select Demo Mode from the main menu:   

      

 
NOTE: The Demo Mode measurement unit can be set in the Settings menu of the Alpha. 

 

5.1.1 Track  

Track mode can be used to execute a very simple tightening operation in which the operator tightens 
the screw at the desired torque, monitoring the torque applied on the Alpha display.    

 

In Track mode, the Alpha displays the applied torque in real time. 
 

Torque can be applied in either the clockwise (positive torque) or counterclockwise (negative torque) 
direction. 
By clicking on the OK button on the keyboard the Alpha executes a torque zero adjustment. 

 
NOTE: The zero adjustment is applied only for this test; it is not applied as a global zero 
reference for the Alpha. 
 
NOTE: The cutoff frequency for the Track test is 100 Hz. 

Torque 

Time 
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5.1.2 Peak 

As for Track mode, Peak mode can be used to perform a very simple tightening operation in which 
the operator tightens the screw at the desired torque, monitoring the torque applied on the Alpha 
display.  
 
In Peak mode, the maximum value reached during tightening remains frozen on the Alpha display. 

 

 

The Alpha displays torque in real time, starting from the Min. Load value, and the peak value 
(measured on the torque) is frozen on the display: 

             
A new cycle starts when the applied torque is released, and applied again over the Min. Load of the 
Alpha.  
By clicking on the OK button on the Alpha keyboard the torque value is reset.  
The torque must be applied in the clockwise direction. 

 
NOTE: The cutoff frequency for the Peak test is 100 Hz. 
 

 
 
 
 
 
 
 
 

Torque 

Time Min. Load 

Displayed Torque 
Applied Torque 
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6 TESTING CLICK-WRENCHES 

 
The goal of the “Click-wrench Test” is to detect the “click-point” of the wrench: 

  The click-point is detected when the torque drops down and then increases again, producing the 
typical shape of the “click” phenomenon (refer to the following examples):   
 

                                         
If the torque only drops down to zero (without increasing again) after a peak-point (as shown in the 
figure below), the click-point is not detected. For this reason, slip-wrenches cannot be tested with this 
method (slip-wrenches should be tested with the peak-wrench function): 

 
If the test ends and the click-point is not detected, the message “not detected” is shown on the 
display. In this case the result is the “torque absolute peak”.  
 

Click-point 

Time 

Torque 

Click-point Click-point 

Torque 

Time 

This point is not 
detected as click-point 
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To perform the “Click-wrench Test”, select Measurement → Click Wrench from the main menu: 
 

             
 
During the “Click-wrench Test”, the torque result and statistics are displayed: 

 
The display background color changes according to the tightening phase and result: 
 

Blue Default color used for Pset execution.  

Green  The display turns green if the click-point is detected. 

Red  Click-point not detected or torque over the overload value. 

 

The buzzer is activated as follows: 
 

Buzzer Three high tones are emitted if the click-point is detected.  
A lower tone is emitted if the click-point is not detected. 

6.1 Test Setup for Click-wrenches 

The regulation of the click-wrench test parameters is important to adjust and customize the test process. 
 

Select the Measurement Setup → Click Wrench from the main menu: 

 
The following screen is displayed: 
 

 

Scroll the parameters by means of the UP/DOWN buttons (placed on the Alpha keyboard) and press 
OK to edit. Finally, press OK again to confirm the new value or CL to quit without saving. 
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6.1.1 Measurement unit 

The “Measurement unit” area allows the user to select the desired measurement unit between the 
following: Nm, dNm, kpm, Ozfin, Ozfft, Lbfin, Lbfft, kgfcm, kgfm. 

6.1.2 Tightening direction 

The “Tightening direction” area allows the user to select one of the following options: 

• CW : The test must be executed in the clockwise direction. 

• CCW : The test must be executed in the counterclockwise direction. 

• CW&CCW: The test can be executed in both the directions. When the torque goes over the 
minimum load, the test starts and considers positive the direction of the torque applied. 

6.1.3 Timeout  

The “Timeout” area defines the end of the test. When the torque is below the cycle start for the 
assigned timeout, the test ends.  
 

 

 

NOTE: The “Timeout” can be set from 100 ms up to 2000 ms. The default value is 100 ms. 

 

Torque 

The test ends when 
torque remains under 
the cycle start for the 

assigned timeout 
 

If torque goes over the cycle 
start before the assigned 
timeout, the test goes on 

 

Time 

Timeout Timeout 

Transducer full scale 

Cycle start 
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6.1.4 1st threshold (THR 1) 

The “1st threshold” is used to detect the click point of the wrench.  
The torque must continuously decrease from the measured peak at least for the specified value, in 
order that it can be considered the click point.  
The 1st threshold default value is 5%, and it is calculated on the relative torque peak value reached 
during the test: 

 
For instance, if the peak is 100 Nm and the 1st threshold is set to 5%, the torque must go under 95 
Nm, in order that it can be considered the click point. 
 
The default value suits many of the click-wrenches.  
However, it might be necessary to adjust it according to the specific wrench that is testing.  
For example, if the click point produces a big drop in the torque, the 1st threshold may be increased, 
in order to avoid detecting false click points at lower torque values (refer to the following figure): 

 

 

 

 
 
 
 

Click point 

Time 

1st threshold 

If torque goes below 
the 1st threshold, the 

click point is detected 
 

Torque 

If the click produces a big 
torque drop, the 1st threshold 

may be increased 
 

False click point: 
not detected 

 



 Part Number 
Issue  
Date 
Page 

6159938890 
13 
02/2023 
57 / 96 

 

57 (96)  02/2023 

On the other side, if the click point produces only a little drop in the torque, the 1st threshold may be 
decreased in order to detect the click point: 

 

 
NOTE: By decreasing the threshold, the risk to detect false click points increases. 
 

To summarize, the 1st threshold must be set neither too low (in order to avoid the detection of false 
click) nor too high (in order to detect the real click point). 

6.1.5 2nd threshold (THR 2) 

The “2nd threshold” is used to 
exclude all the part of the curve 
below a certain value from the 
analysis, where false click may 
occur if the operator movement is 
not enough steady.  
The 2nd threshold default value is 
70% and it is calculated on the 
maximum torque value reached 
during the test. 
 
Under the specified threshold the 
torque is not considered by the 
Alpha. 

 

 

 

NOTE: All the “click” phenomena, 
including the point when the torque 
starts increasing again after the 
“click”, must be over the 2nd 
threshold.  

If not, the click point is not 
detected: 

                        

If the click produces a little 
torque drop, the 1st threshold  

may be decreased 
 

False click, that may be 
detected as the click point 
 

2nd threshold  

Time 

Max. torque 

Torque 

Time 

Torque 

In this case the 
click point is not 

detected 2nd threshold  
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6.1.6 Cutoff frequency (Fcut) 

The “Cutoff frequency” can be set to 100, 200, 500 or 1000 Hz: this is applied to the samples 
measured by the torque transducer in order to filter the noise.  
The default value is 100Hz, that is a convenient value for most of the click-wrenches. However, it may 
be necessary to increase this value (for the tools where the default value does not suit the specific 
tool characteristics).  

6.1.7 Result 

The “Result” area defines which peak must be regarded as torque result.  

If Peak Click is selected, the first peak (click point) is considered as result of the test (refer to the 
figure below). 

If Abs. Peak is selected, the maximum torque is considered as result of the test (refer to the figure 
below). 

6.1.8 Cycle start 

The “Cycle start” area defines the torque level where the test starts and (after the timeout) ends. 
 
It is expressed in percentage (%) in comparison with the Alpha capacity. Furthermore, it can range 
from the Minimum Load (defined in the Transducer Info – refer to the paragraph “Transducer” for 
further details) to the Alpha capacity. 

Torque 

If Peak Click is selected, 
the first peak (click point) 
is considered as result of 

the test 

If Abs. Peak is 
selected, the maximum 
torque is considered as 

result of the test 

2nd threshold  

Time 
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7 TESTING NUTRUNNERS 

The “Nutrunners” are those tools that provide real torque to the joint (for example battery tools, 
pneumatic tools (not impulse) and electronic controlled tools). 

During “nutrunner test”, the torque result shown by the Alpha is the peak value measured during the 
test. 

 
 
NOTE: In case of multiple peaks, the result is the first peak.  
 
 
NOTE: It is MANDATORY that the peak must satisfy the two thresholds specified (refer to the 
paragraph “1st threshold and 2nd threshold (THR 1 and THR 2)” for further details). 

 

 

 

 

 

 

 

Time 

Torque 
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To test a power tool on the Alpha, a mechanical joint simulator must be used in order to let the tool 
rotating (refer to the figures below): 

 
To perform the “Nutrunner Test”, select Measurement → Nutrunner from the main menu: 
 

 
During the “Nutrunner Test”, the torque result and statistics are displayed: 

 
The display background color changes according to the tightening phase and result: 
 

Blue Default color used for Pset execution.  

Green  The display turns green if the peak-point is detected. 

Red  Peak-point not detected or torque over the overload value. 

 

The buzzer is activated as follows: 
 

Buzzer Three high tones are emitted if the peak-point is detected.  
A lower tone is emitted if the peak-point is not detected. 

Joint 
simulator 

Joint 
simulator 
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7.1 Test Setup for Nutrunner Test 

The regulation of the nutrunner test parameters is important to adjust and customize the test process. 
 

Select the Measurement Setup → Nutrunner from the main menu: 
 

 
The following screen is displayed: 

 
Scroll the parameters by means of the UP/DOWN buttons (placed on the Alpha keyboard) and press 
OK to edit. Finally, press OK again to confirm the new value or CL to quit without saving. 

7.1.1 Measurement unit 

The “Measurement unit” area allows the user to select the desired measurement unit between the 
following: Nm, dNm, kpm, Ozfin, Ozfft, Lbfin, Lbfft, kgfcm, kgfm. 

7.1.2 Tightening direction 

The “Tightening direction” area allows the user to select one of the following options: 

• CW : The test must be executed in the clockwise direction. 

• CCW : The test must be executed in the counterclockwise direction. 

• CW&CCW: The test can be executed in both the directions. When the torque goes over the 
minimum load, the test starts and considers positive the direction of the torque applied. 
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7.1.3 Timeout 

The “Timeout” area defines the end of the test. When the torque is below the cycle start for the 
assigned timeout, the test ends.  

 
For two-steps tools, it allows the tool to switch between the two steps without ending the test. 

 

 

NOTE: The “Timeout” can be set from 100 ms up to 2000 ms. The default value is 100 ms. 

Time 

Transducer full scale 

Timeout 

The test ends when 
torque remains below 
the cycle start for the 

assigned timeout 

Torque 

Cycle start 

Time 

If torque goes over the cycle 
start before the timeout, the 

test goes on 
 

Cycle start 

Transducer full scale 

Torque 

Timeout Timeout 



 Part Number 
Issue  
Date 
Page 

6159938890 
13 
02/2023 
63 / 96 

 

63 (96)  02/2023 

7.1.4 1st threshold and 2nd threshold (THR 1 and THR 2)  

The two thresholds are used to setup the test for the type of tool under test.  
 
The “1st threshold” is used to detect the peak value of the torque. The torque must continuously 
decrease from the measured peak at least for the specified value.  
The 1st threshold default value is 5%, and it is calculated on the relative torque peak value reached 
during the test. 
 
The “2nd threshold” is used to exclude from the analysis all the parts of the curve below a certain 
value, where there may be noise. The 2nd threshold default value is 80%, and it is calculated on the 
maximum torque value reached during the test. Under the specified threshold the torque is not 
considered by the Alpha. 

 

For instance, if the peak is 100 Nm and the 1st threshold is set to 5%, the torque must go under 95 
Nm. 
For a generic nutrunner these settings should be not critical and the default value should suit almost 
all of the tools. For quickstep or two-steps tools, the 2nd threshold is used to exclude the first step from 
the measurement; if it is not set properly, the peak of the first step is considered as result of the test: 

Max. torque 

2nd threshold  

Time 

1st threshold 

Torque 

Time 

The 2nd threshold must 
be higher than the 

peak of the first step 
 

First step 
 

Second step 
 

Max. torque 

2nd threshold  

1st threshold 

Torque 
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7.1.5 Cutoff frequency (Fcut) 

The “Cutoff frequency” can be set to 100, 200, 500 or 1000 Hz: this is applied to the samples 
measured by the torque transducer in order to filter the noise.  
The default value is 500Hz. However, it may be necessary to increase/decrease this value (for the 
tools where the default value does not suit the specific tool characteristics). 

7.1.6 Cycle start 

The “Cycle start” area defines the torque level where the test starts and (after the timeout) ends. 
 
It is expressed in percentage (%) in comparison with the Alpha capacity. Furthermore, it can range 
from the Minimum Load (defined in the Transducer Info – refer to the paragraph “Transducer” for 
further details) to the Alpha capacity. 
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8 TESTING PULSE TOOLS 

The “Pulse Tools” provide a set of pulses to tighten the joint.  
 
A Pulse Tool can be tested on the Alpha.  

 
NOTE: If the Pulse Tool has the shut-off valve, one of the two mechanical joint simulators 
provided with the Alpha must be used: 

                     

        

 
 
WARNING: Impact tools cannot be tested on the Alpha. 

 

 

 

Torque 

Time 

Time 

No shut-off valve  

Shut-off valve  
Torque 

Joint 
simulator 
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To perform the “Pulse Tool Test”, select Measurement → Pulse Tool from the main menu: 

 
During the “Pulse Tool Test”, the torque result, statistics and pulse tool frequency are displayed: 

 
The display background color changes according to the tightening phase and result: 
 

Blue Default color used for Pset execution.  

Green  The display turns green if the result is within the transducer 
overload. 

Red  Torque over the overload value. 

 

The buzzer is activated as follows: 
 

Buzzer Three high tones are emitted if the peak-point is detected.  

8.1 Test Setup for Pulse Tool Test 

The regulation of the pulse tool test parameters is important to adjust and customize the test process. 
 

Select the Measurement Setup → Pulse Tool from the main menu: 

 
The following screen is displayed: 

 
Scroll the parameters by means of the UP/DOWN buttons (placed on the Alpha keyboard) and press 
OK to edit. Finally, press OK again to confirm the new value or CL to quit without saving. 
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8.1.1 Measurement unit 

The “Measurement unit” area allows the user to select the desired measurement unit between the 
following: Nm, dNm, kpm, Ozfin, Ozfft, Lbfin, Lbfft, kgfcm, kgfm. 

8.1.2 Tightening direction 

The “Tightening direction” area allows the user to select one of the following options: 

• CW : The test must be executed in the clockwise direction. 

• CCW : The test must be executed in the counterclockwise direction. 

• CW&CCW: The test can be executed in both the directions. When the torque goes over the 
minimum load, the test starts and considers positive the direction of the torque applied. 

8.1.3 Timeout 

The “Timeout” area defines the end of the test. When the torque is below the cycle start for the 
assigned timeout, the test ends. 

 

 

NOTE: The “Timeout” can be set from 100 ms up to 2000 ms. The default value is 100 ms. 
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8.1.4 Threshold (THR 2) 

 
 
 
The “Threshold” area is used in order to filter 
the curve for proper peak detection: this is useful 
for the frequency calculation. Once detecting 
every peak, all the values under the threshold 
are discarded. This action filters all the bounces 
always present in a pulse tightening. 
 

The “Threshold” default value is 80%.  
 
 
 
 
 
 
 

8.1.5 Cutoff frequency (Fcut) 

The “Cutoff frequency” can be set to 100, 200, 500, 1000 or 2000 Hz: this is applied to the samples 
measured by the torque transducer in order to filter the noise.  
The default value is 2000Hz. However, it may be necessary to decrease this value (for the tools 
where the default value does not suit the specific tool characteristics). 

8.1.6 Torque coefficient (K tuning) 

Pulse Tools do not provide a continuous torque output; they generate a single high energy pulse with 

very short duration ( 1ms). This set of pulses results in the tightening of a fastener. The final torque 
reached cannot be measured directly (as for real torque tools), due to the physical characteristics of 
the tool. The reason is that the Pulse Tools provide a very high torque for such a short time that only a 
part of these peaks is translated into the tightening of the fastener (generating more clamping force). 
This depends on many factors such as the bolt mass, friction, the stiffness of the joint, etc... 
 
The torque coefficient is used to align the torque measured by the transducer with the real torque 
produced on the joint.  
 
The torque produced on the 
real joint is always lower 
(ideally equal) than the peak 
torque measured on the 
transducer. Therefore, this 
coefficient can be set to 
values between 100 and 
10000 (the value is entered in 
thousandths, thus 500 
corresponds to 0.500 and 
1000 correspond to 1.000). 
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The only way to evaluate the actual torque is to make a residual torque check on the real joint. The 
relation between the peak torque measured on the transducer and the actual torque on the joint is 
affected by all the components: the Pulse Tools, the adapters, the transducer and the joint itself.  
If any of these components is changed, the relation peak torque – actual torque must be recalculated. 
 
The following process must be used to regulate the Pulse Tool in order to provide the desired torque 
on the real joint and to calculate the proper coefficient K: 

 

For instance, consider a target torque for the joint equal to 100 Nm. Once the tool regulation is made, 
the residual torque check is equal to 100 Nm. 
If the torque measured on the transducer is equal to 120 Nm, the coefficient K corresponds to 
100/120 = 0.83; due to the fact that the value is entered in thousandths, the coefficient K is equal to 
830. 

8.1.7 Cycle start 

The “Cycle start” area defines the torque level where the test starts and (after the timeout) ends. 
 
It is expressed in percentage (%) in comparison with the Alpha capacity. Furthermore, it can range 
from the Minimum Load (defined in the Transducer Info – refer to the paragraph “Transducer” for 
further details) to the Alpha capacity. 

Set a low torque 
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9 PEAK TEST 

The “Peak Test” provides the maximum torque measured during the test.  
 
NOTE: The typical application of this method is the test of Slip-wrenches (refer to the next 
paragraph “Testing Slip-wrenches” for further details). 
 

9.1 Testing Slip-wrenches 

 
The “slip-point” point is the peak value of the curve. 

 
The torque result is the peak value measured during the test.  
  
To perform the “Peak Test”, select Measurement → Peak from the main menu: 
 
 

 
 
 
 
 
 

Slip-point 

Time 

Torque 
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During the “Peak Test”, the torque result and statistics are displayed: 

 
The display background color changes according to the tightening phase and result: 
 

Blue Default color used for Pset execution.  

Green  The display turns green if the test ends within the transducer 
overload. 

Red  Torque over the overload value. 

 

The buzzer is activated as follows: 
 

Buzzer Three high tones are emitted to advice the user about the end of 
the test.  

9.2 Test Setup for Peak Test 

The regulation of the peak test parameters is important to adjust and customize the test process. 
 

Select the Measurement Setup → Peak from the main menu: 

 
The following screen is displayed: 

 
Scroll the parameters by means of the UP/DOWN buttons (placed on the Alpha keyboard) and press 
OK to edit. Finally, press OK again to confirm the new value or CL to quit without saving. 

9.2.1 Measurement unit 

The “Measurement unit” area allows the user to select the desired measurement unit between the 
following: Nm, dNm, kpm, Ozfin, Ozfft, Lbfin, Lbfft, kgfcm, kgfm. 
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9.2.2 Tightening direction 

The “Tightening direction” area allows the user to select one of the following options: 

• CW : The test must be executed in the clockwise direction. 

• CCW : The test must be executed in the counterclockwise direction. 

• CW&CCW: The test can be executed in both the directions. When the torque goes over the 
minimum load, the test starts and considers positive the direction of the torque applied. 

9.2.3 Timeout 

The “Timeout” area defines the end of the test. When the torque is below the cycle start for the 
assigned timeout, the test ends. 

 

 

NOTE: The “Timeout” can be set from 100 ms up to 2000 ms. The default value is 100 ms. 

 

NOTE: For Slip-wrenches, the operator has to operate the wrench until the slip-point is 
reached; then, he has to stop the wrench rotation. When the timeout default value is set, if the 
operator continues to rotate the wrench producing more slip-points, each of them will produce 
a test result:  
 

 
 

Setting a longer timeout, only the higher 
of the two points will produce a result 

 

With a default short timeout, both of 
the two slip- points will produce a result 
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the cycle start for the 
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9.2.4 Cutoff frequency (Fcut)  

The “Cutoff frequency” can be set to 100, 200 or 500 Hz: this is applied to the samples measured by 
the torque transducer in order to filter the noise.  
The default value is 100Hz. However, it may be necessary to increase this value (for the tools where 
the default value does not suit the specific tool characteristics). 

9.2.5 Cycle start 

The “Cycle start” area defines the torque level where the test starts and (after the timeout) ends. 
 
It is expressed in percentage (%) in comparison with the Alpha capacity. Furthermore, it can range 
from the Minimum Load (defined in the Transducer Info – refer to the paragraph “Transducer” for 
further details) to the Alpha capacity. 
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10 ALPHA SETTINGS 

10.1 Language 

To set the Alpha display language, select Settings → Language from the Alpha main menu: 
 

                
Select the language and confirm with the OK button on the keyboard. 

 
NOTE: It is possible to set the language also by means of the DeltaQC software, by selecting 
the Controller → Configuration menu: 

 

10.2 Date - Time 

To set the Alpha date and time, select Settings → Insert Date – Time from the Alpha main menu: 

 
                

Use the right/left arrows on the keyboard to choose the field to edit, and use the up/down arrows to 
increase/decrease the selected field. 
 

 
NOTE: To select either European or American date format, select Settings → Date menu. 
 

Select the language 
and click on Save icon 
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NOTE: It is possible to set the date and time also by means of the DeltaQC software, by 
selecting the Controller → Configuration menu: 

 

10.3 Demo mode unit 

To set the Alpha unit of measurement for the Demo Mode select Settings → Demo Mode unit from 
the Alpha main menu:                

 
Select the measurement unit to be used in the Demo Mode menu, and confirm with the OK button 
placed on the keyboard. 

10.4 Alpha Name 

The name shown on the software can be set by means of the DeltaQC software, by selecting the 
Controller → Configuration menu: 

Select the date and time; 
then click on the Save icon 
 

Click on the Refresh icon 
to set the date and time of 

the PC on the Alpha 
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10.5 Result confirmation option 

By enabling the “Result confirmation option”, the Alpha can manage the results (according to the 
setting selected). Thus, select the Controller → Configuration menu:  
 

 
 

 
 
The possible settings are as follow: 

• Never: Function disabled: each test result is saved in the Alpha memory. 

• Always: After each test, the Alpha asks the user to accept / discard the result. 

• NOK only: Only after a test with Not OK result, the Alpha asks the user to accept / discard the 
result. 

The Alpha Name is shown in the 
Assembly Line area of the main 
page of the Delta QC software  

 

Set the Alpha name and 
click on the Save icon 
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10.6 Information 

This window provides some general information about serial number, the firmware version, the Type 
and the Battery charge status:  

10.7 Memory 

From the Controller → Memory menu it is possible to delete the Transducers, the Results, the 
Diagnostics and the Curves stored into the Alpha memory: 
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11 RESULTS VIEWER 

 
The Results viewer function allows the user to retrieve the results from the Alpha. 
 

 
The Alpha can store up to 1000 results; when the memory is full the new results overwrite the oldest 
results stored. 
 
To view the results stored on the Alpha, connect the instrument to the DeltaQC and click on the 
Result Viewer icon: 

 
 
 
 
 
 
 
 
 
 
 

Results Viewer icon 

Alpha connected with the PC 
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When clicking on the Result Viewer icon, the following screen is shown:  

   
Select the test(s) to be reviewed and finally click on OK. 

The following “Results Viewer page” is shown: 
 

 
Click on a column heading in order to organize the results according to the column selected. 

All the information related to the tightening operation is displayed in the whole set of columns. 

If an item has been deleted after the test execution, the related rows with the results are marked as 
“deleted”. 
 
 
 
 

Search / filter 
functions 

 

Select/unselect all 
 

Select manually 
the item 

 

Results found 
Filters drop-
down menu Progress bar 

Delete button 

Export button 

Pset Filter 
button 

Main Toolbar Select/deselect all the results 
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The Main Toolbar (refer to the above screen) allows the user to customize the Results Viewer page. 
Furthermore, it provides important data. 
 
The “Filters drop-down menu” (refer to the above screen), filters the results according to customer 
needs. It is possible to display the results after selecting among the following options: No Filter, 
Status OK, Status KO, Torque status OK, Torque status KO, Angle status OK, Angle status KO. 
 
The “Pset Filter” button (refer to the above screen), allows the user to filter the results according to the 
test that made them.  
After clicking on “Pset Filter” button, the following pop-up is shown:  

 
Select the test to be reviewed and click on OK. 
 
 
The “Progress bar” and the “Results found” options provide important data related to the results. 
 
The “Progress bar” (refer to the above screen) is a graphical control element used to visualize the 
progression of the results downloaded: when it is totally green, all the results are downloaded. 
 
The “Results found” option (refer to the above screen) indicates the number of results either 
performed (Online mode) or stored into the database (Offline mode). 
 
The “Delete” button (refer to the above screen) is not available. 
 

 
 
 

Search / filter 
functions 

Select manually 
the tests 

 

Select/deselect 
all the tests 
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The “Export” button (refer to the above screen) allows the user to save the results list in an Excel (.xlsx) file. 
Manually select the result(s) to be saved. Then click on “Export” button; the following window is shown: 

 
The File name is automatically assigned, even if it is editable according to customer needs. Select the 
Destination Folder and click on Save.  
The Excel file is automatically open:  
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The Results Viewer page shows a group of records (organized in columns) that meet the search 
criteria set by the customer. 
The most important columns are summarized in the following table: 
 

Status This is the global status of the test. It is OK when the result has 
been detected according to the thresholds and limits specified, 
and if the torque does not exceed the maximum transducer 
overload.  

Torque Status  These fields indicate the result for the torque. If the result is within 
the torque limits, the status is OK.  
 
If the torque goes over the maximum transducer overload the 
result is marked as HIGH.  

Result number Progressive number automatically assigned by the Alpha to every 
tightening result.  

Min value: 1  
Max value: 1000  

When 1000 results are stored in the Alphs memory, the new 
results overwrite the oldest starting from result number 1.  

Torque result Torque values measured by the Alpha. 

Date / Time Fields indicating the date and time of the tightening operation. 
Date and time are taken from the date and time set on the Alpha. 

Unit of Measurement Unit of measurement. 

Result detailed 
 

This field explains the reason for a Not OK test (for example, 
click-point not detected for a Click-wrench test). 
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12 CURVES VIEWER 

 
Click on the Curves viewer icon to retrieve the curve from the Alpha. 
 

 
The Alpha can store up to 10 curves (the maximum time length allowed per each curve is equal to 30 
seconds); when the memory is full, the new curves overwrite the oldest ones stored. 
 
To view the curves stored on the Alpha, connect the instrument to the DeltaQC and select the Curves 
Viewer icon (refer to the screen below): 
 

 
 
 
 
 
 
 
 
 
 

Curves Viewer icon 

Alpha connected with the PC 
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12.1 View One Curve  

Select the curve to display by clicking on the bar at the top part of the following screen:  

 
The last curve performed can be recognized due to the “(LAST)” placed close to the curve number. 
The Refresh key (placed on the left upper corner of the above screen) refreshes the window in case 
a new curve is available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select among 10 curves 
 

Toolbar 

Selected curve 

Refresh key 
 

Last curve performed 
 

Delete key 
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In the Curve Type, Limits and Results areas it is possible to select what to display on the graph: 
 

 
It is possible to select the Torque curve, Angle curve, 
Torque/Angle curve or both Torque and Angle curve on the 
same graph. 
If limits and results are enabled, they are shown in the graph. 
The Result indicates (on the curve) the point where the result is 
taken. If the result is Not OK, it will be marked with a red X 
(refer to the example below): 
 
 
 

 
To zoom in on a section of the curve, simply select the desired area with the mouse:   

Select the area 
to zoom in 

Right-click to navigate 
in the zoom curve 

Select what to 
view on the graph 

Torque max. 

Torque 
curve 

Result 

Torque min. 
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While zoom in, to navigate the graph right-click on the curve and move the mouse pointer on the 
graph. 
 
To zoom out to the whole curve, press the left button on the mouse, move the cursor up/leftward, and 
release the left button: 

 
The curve parameters window displays detailed information on the curve. They are shown on the left 
side: 
 

 
 
 

2.  Move up/leftward and 
release the left button 

1. Click anywhere in the curve area 

Curve 
parameters 
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To evaluate the curve in details, click on Show cursor to activate the cursor on the graph. 

12.2 Export a Curve 

Some useful keys are available in the toolbar:  
 

 
This key exports the curve values in a Excel file. 

 

This key creates a Report 
(refer to the figure on the 
right): 
 
 
 
 
 
 
 
 
 
 
 
 
The Report can be printer or 
exported into Excel / PDF by 
means of the commands 
placed in the report toolbar. 

Show / Hide 
Cursor 

 

Cursor 
 

Curve data at the 
cursor position 

 

Toolbar 
 

Scroll the Report 
for further details 
 

Report 
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This key creates a .jpg file of the 
curve: 
 

12.3 Curves Comparison  

This feature overlaps the curves for a comparison of the tightening operations. 
 

Click on Compare to open the “comparison screen”:  

 
Select on the left side of the screen (in the Curves list) the curves to compare. 
 
Select the type of graph (Torque/Time, Angle/Time, or Torque/Angle) by means of the Curve Type 
scroll window. 
 
In the Curves parameters window all of the parameters and results of the curves are displayed. Click 
on the + or – icons to expand or collapse the nodes. 
 

Select the curves 
to compare 

Curves parameters 

Curve type 
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13 MAINTENANCE 

13.1 Yearly calibration 

The Alpha needs to be recalibrated every year. Contact the Customer Center for calibration. 

13.2 Cleaning 

Keep the Alpha clean. 
 
After use, remove any curves of oil, grease and dust from the Alpha, especially from the display, the 
keyboard, the connectors and the transducer. 
Avoid using harsh detergents to clean the Alpha. 
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14 TROUBLESHOOTING GUIDE 

 
Hereunder is a quick Troubleshooting Guide for the Alpha. 
 
If a problem is shown, before taking any action (replacing parts or contacting customer support), be 
sure to check that the Alpha is being used properly; improper operation can cause defeats even if the 
system is in good working order.  
In case of issues, the log file can provide information about the problem (refer to the paragraph “Alpha 
LOG Viewer” for further details). 
  

Symptom Possible cause Solution 

Test result is always Not 
OK when testing a tool, 
or the click-point of a 
wrench is never detected 

- Ensure to use proper 
setup 

- Check and eventually modify the test 
setup parameters (the thresholds are the 
most critical parameters) 

The overload message is 
shown even if the torque 
is below the capacity 

- Overload set below 
100% 

- Check the setting of the overload 
parameter in the Transducer Info from the 
main menu (refer to the paragraph 
“Transducer” for further details) 

The test takes too long 
time to complete 

- Timeout set to high 
value 

- Check the timeout value in the 
Measurement Setup from the main menu 

Test on pulse tools does 
not give correct results 

- K tuning coefficient not 
set properly 

- Check the K tuning coefficient value in 
the Measurement Setup → Pulse Tool 
menu 

14.1 Alpha Diagnostic  

The diagnostic menu can be used to perform a check of the Alpha hardware. 
Select Diagnostic from the Settings menu and press the OK button to start the diagnostic 
procedure: 

                                  
The diagnostic procedure leads the user to check all the Alpha hardware.  
The diagnostic procedure is interactive: simply follow the instructions given on the Alpha display to 
complete the diagnostic; if a component gives a Not OK result during the test, it should be repaired or 
replaced. 
 

NOTE: If the test on some buttons of the Alpha keyboard gives Not OK result, all the following 
tests requiring the operator to use that button to confirm the test result will not be performed, 
and will be marked as N.A. (Not Applicable). 
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The last ten diagnostic reports are saved in the Alpha memory and can be retrieved by the DeltaQC. 
Connect the Alpha to the DeltaQC and select the Controller → Diagnostic menu: 

 
The following screen is shown: 

 
Each report is marked (in the left column) either in green if all of the test are OK (or not applicable) or 
in red if at least one test gives a Not OK (NOK) result.  
 
The last report is marked as LAST.  
 
The toolbar in the upper area of the Diagnostic Report provides functions to print the report or export 
it to Excel or PDF file. 

Diagnostic 
Report 

Select a 
Report 
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15 ABBREVIATIONS 

 

Abbreviation Description Abbreviation Description 

A Ampere n Numbers (of values) 

AC Alternating current N.A. Not Applicable 

Avg Average Nm  Newton meter 

CCW Counter clockwise Nr. Number 

CW Clockwise OK  Approved (test) 

dBm Decibel referred to milliwatt NOK Not approved (test) 

DC Direct current PC Personal Computer 

EMC  Electromagnetic Compatibility Std Standard deviation 

EMI Electromagnetic Interference SW Software 

ESC Exit USB Universal Serial Bus 

Hz 
Hertz (measurement unit of 
frequency) 

V Volt 

Max  Maximum VIN Vehicle Identification Number 

Min  Minimum WEEE 
Waste Electrical and Electronic 
Equipment 

ms millisecond   

 
 
 
 
 
 
 
 
 
 
 
 
© Copyright 2011, Desoutter 
All rights reserved. Any unauthorised use or copying of the contents or part thereof is prohibited. This 
applies in particular to trademarks, model denominations, part numbers and drawings. Use only 
authorised parts. Any damage or malfunction caused by the use of unauthorised parts is not covered 
by Warranty or Product Liability 
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(1)  DECLARATION OF CONFORMITY 
            (Fr) DECLARATION DE CONFORMITE 

 
(2)   We:      (3) Technical file available from EU headquarter.  
       (Fr) Nous                  (Fr)  Dossier technique disponible auprès du siège social 

 Desoutter Ltd                  Nicolas Lebreton, R&D Manager 
 Zodiac – Unit 4    CP 
 Boundary Way    38 rue Bobby Sands – BP 10273 
 Hemel Hempstead    44818 Saint Herblain – France 

   Herts – UK  
    HP2 7SJ 
 
 

(4)  Declare that the product(s):   Alpha  
 (Fr) déclarons que les produits   Alpha 
 
(5)  Machine type(s):  
 (Fr) type(s) 
 
 
 
 
 

 (6)     Origin of the product: Italy 
 (Fr) Origine du produit 
 
(7) Is in conformity with the requirements of the council Directives on the approximation of the laws 

of the Member States relating: 
(Fr) est (sont) en conformité avec les exigences de la Directive du conseil, concernant les législations des 
états membres relatives: 
 

(8) To “Risk of Hazardous Substances (ROHS)” 2011/65/EC (21/07/2011) 
 (Fr) aux “Risque de substances dangereuses (ROHS)” 2011/65/EC (21/07/2011) 
 
(9)  To “Electromagnetic Compatibility” 2004/108/EC (15/12/2004) 
 (Fr) aux “Compatibilité électro-magnétique” 2004/108/EC (15/12/2004) 
 
 
 (11)   Applicable harmonised standard(s):   
 (Fr) Norme(s) harmonisée(s) applicable(s): 
 
 
 
 
 
 
 
 

(12)  NAME and POSITION of issuer:     Nicolas LEBRETON   

 (Fr) NOM et FONCTION de l'émetteur :         (R&D Manager) 
 
 
(13)  Place & date: Saint Herblain XX/XX/20XX 
 (Fr) Place et dat 

 
 
 
 
 
 
 
 

Model 
(Modèle) 

Part Number 
(Référence) 

Serial Number 
(N° série) 

ANY ANY ANY 

EN 61010-1:2010 → 

Safety Requirements for Electrical 
Equipment for Measurement, 
Control and Laboratory Use – Part 
1: General Requirements 

EN 61326-1:2013 → 

Electrical Equipment for 
Measurement, Control and 
Laboratory Use – EMC 
Requirements 
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(1)  DECLARATION OF CONFORMITY 
            (Fr) DECLARATION DE CONFORMITE 

DEUTSCH (GERMAN) (1) EG-KONFORMITÄTSERKLÄRUNG - (2) Wir, DESOUTTER – (3) Technische Datei beim EU - (4) 
erklärenhiermit, daß das (die) Produkt(e) : - (5) Typ(en): - (6) Produktherkunft - (7) den Anforderungen der EG-Richtlinie zur Angleichung 
der Rechtsvorschriften der Mitgliedsstaaten - (8) für “Maschinen” 2006/42/EG (17/05/06) - (9) für “Elektromagnetische Störfreiheit” 
2004/108/EG (15/12/04) - (10) für “Niederspannung” 2006/95/EG (12/12/06) - entspricht (entsprechen). - (11) geltende harmonisierte 
Norme(n) - (12) NAME und EIGENSCHAFT des Ausstellers: - (13) Datum: 
 
NEDERLANDS (DUTCH) (1) E.G.-VERKLARING VAN OVEREENSTEMMING - (2) De firma : DESOUTTER - (3) Technisch bestand 
verkrijgbaar - (4) verklaart hierbij dat het (de) produkt(en): - (5) type: - (6) Herkomst van het product - (7) in overeenstemming is (zijn) met 
de vereisten van de richtlijn van de Raad inzake de onderlinge aanpassing van de wetgevingen van de lidstaten betreffende: - (8) 
“machines” 2006/42/CEE (17/05/06) - (9) “elektromagnetische compatibiliteit” 2004/108/EG (15/12/04) - (10) “laagspanning” 
2006/95/EG (12/12/06) - (11) geldige geharmoniseerde norm(en) - (12) NAAM en FUNCTIE van de opsteller: - (13) Datum: 
 
SVENSKA (SWEDISH) (1) EG-DEKLARATION OM ÖVERENSSTÄMMELSE - (2) Vi DESOUTTER - (3) Teknisk fil tillgänglig från - (4) 
Förklarar att maskinen: - (5) Maskintyp: - (6) Produktens ursprung - (7) För vilken denna deklaration gäller, överensstämmer med kraven i 
Ministerradets direktiv om harmonisering av medlemsstaternas lagar rörande - (8) “maskiner” 2006/42/EEG (17/05/06) - (9) 
“elektromagnetisk kompatibilitet” 2004/108/EEG (15/12/04) - (10) “lågspänning” 2006/95/EEG (12/12/06) - (11) Harmoniserade 
standarder som tillämpats: - (12) Utfärdarens namn och befattning: - (13) Datum: 
 
NORSK (NORWEGIAN) (1) EF ERKLÆRING OM OVERENSSTEMMELSE - (2) Vi DESOUTTER - (3) Teknisk dokument tilgjengelig - (4) 
Erklærer at produktet/produktene: - (5) av type: - (6) Produktets opprinnelse - (7) er i overensstemmelse med de krav som finnes i 
Ministerrådets direktiver om tilnærming av Medlemsstatenes lover vedrørende: - (8) “maskiner” 2006/42/EF (17/05/06) - (9) 
“elektromagnetisk kompatibilitet” 2004/108/EF (15/12/04) - (10) “lavspenning” 2006/95/EF (12/12/06) - (11) Harmoniserende 
standarder som er anvendt: - (12) Utsteders navn og stilling: - (13) Dato: 
 
DANSK (DANISH) (1) EF OVERENSSTEMMELSESERKLÆRING - (2) Vi DESOUTTER - (3) Teknisk dokument kan fås på - (4) erklærer at 
produktet(erne): - (5) type: - (6) Produktets oprindelse - (7) er i overensstemmelse med kravene i Rådets Direktiv vedr. Tilnærmelse mellem 
medlemslandenes love for - (8) “maskiner” 2006/42/EF (17/05/06) - (9) “elektromagnetisk kompatibilitet” 2004/108/EF (15/12/04) - (10) 
"lavspænding" 2006/95/EF (12/12/06) - (11) Gældende harmoniserede standarder: - (12) Udsteder, navn og stilling: - (13) Dato: 
 
SUOMI (FINNISH) (1) ILMOITUS YHDENMUKAISUUDESTA EY - (2) Me Toiminimi DESOUTTER - (3) Tekniset tiedot saa EU:n - (4) 
vakuutamme, että tuote / tuotteet: - (5) tyyppi(-pit): - (6) Tekniset tiedot saa EU:n - (7) on / ovat yhdenmukainen(-sia) neuvoston 
jäsenmaiden lainsäädäntöä koskevien direktiivin vaatimusten kanssa, jotka koskevat: - (8) “koneita” 2006/42/EY (17/05/06) - (9) 
“elektromagneettista yhteensopivuutta” 2004/108/EY (15/12/04) - (10) “matalajännitteitä” 2006/95/EY (12/12/06) - (11) 
yhdenmukaistettu(-tut) soveltuva(t) standardi(t): - (12) ilmoituksen antajan NIMI ja ASEMA: – (13) Päiväys: 
 
ESPAÑOL (SPANISH) (1) DECLARACION DE CONFORMIDAD CE - (2) Nosotros DESOUTTER - (3) Archivo técnico disponible en - (4) 
declaramos que el producto: - (5) tipo de máquina: - (6) Origen del producto - (7) es conforme a los requisitos de la Directiva del Consejo 
sobre la aproximación de las leyes de los Estados Miembros con relación - (8) a la “maquinaria” 2006/42/CE (17/05/06) - (9) a la 
“compatibilidad electromecánica” 2004/108/CE (15/12/04) - (10) a la "baja tensión" 2006/95/CE (12/12/06) - (11) normas armonizadas 
aplicadas: - (12) Nombre y cargo del expedidor: - (13) Fecha: 
 
PORTUGUÊS (PORTUGUESE) (1) DECLARAÇÃO DE CONFORMIDADE CE - (2) Nós DESOUTTER - (3) Ficheiro técnico disponível na - 
(4) declaramos que o produto: - (5) tipo de máquina: - (6) Origem do produto - (7) está em conformidade com os requisitos da Directiva do 
Conselho, referente às legislações dos Estados-membros relacionados com: - (8) “maquinaria” 2006/42/CE (17/05/06) - (9) 
“compatibilidade electromagnética” 2004/108/CE (15/12/04) - (10) “baixa tensão” 2006/95/CE (12/12/06) - (11) Normas harmonizadas 
aplicáveis: - (12) Nome e cargo do emissor: - (13) Data: 
 
ITALIANO (ITALIAN) (1) DICHIARAZIONE DI CONFORMITÀ CE - (2) La Società : DESOUTTER - (3) File tecnico disponibile dal - (4) 
dichiara che il(i) prodotto(i): - (5) tipo: - (6) Origine del prodotto - (7) è (sono) in conformità con le esigenze previste dalla Direttiva del 
Consiglio, sulle legislazioni degli Stati membri relative: - (8) alle “restrizioni dell’uso di sostanze pericolose (ROHS)” 2011/65/CE 
(21/07/11) - (9) alla “compatibilità elettromagnetica” 2004/108/CE (15/12/04) - (10) N/A - (11) norma(e) armonizzata(e) applicabile(i): - 
(12) NOME e FUNZIONE del dichiarante: - (13) Data: 
 
ΕΛΛΗΝΙΚΑ (GREEK) (1) _ΗΛ ΣΗ ΠΙΣΤΟΤΗΤΑΣ ΕΚ – (2) Η εταιρεία : DESOUTTER – (3) Τεχνικός φάκελος διαθέσιμος - (4) δηλώνει 
υπεύθυνα ότι το(τα) προϊόν(-ντα): – (5) τύπου(-ων): – (6) Προέλευση προϊόντος - (7) είναι σύμφωνο(-α) προς τις απαιτήσεις της Οδηγίας 
του Συμβουλίου που αφορά την προσέγγιση των νομοθεσιών των κρατών μελών τις οχετικές με: – (8) τα “μηχανήματα” 2006/42/EOK 
(17/05/06) – (9) την “ηλεκτρομαγνητική συμβατότητα” 2004/108/EOK (15/12/04) – (10) τη “χαμηλή τάση” 2006/95/EOK (12/12/06) – 
(11) εφαρμοστέο(-α) εναρμονισμένο(-α) πρότυπο(-α): – (12) ΟΝΟΜΑ και ΑΡΜΟ(ΙΟΤΗΤΑ του δηλούντος: – (13) Ημερομηνία:  
 
ČESKY (CZECH) (1) PROHLÁŠENÍ O SOULADU S PŘEDPISY ES - (2) My, firma DESOUTTER – (3) Technický soubor, dostupný - (4) 
prohlašujeme, že výrobek (výrobky): – (5) typ přístroje (přístrojů): – (6) Původ výrobku - (7) je v souladu s požadavky směrnic Rady EU o 
aproximaci práva členských států EU, a to v těchto oblastech: – (8) „přístroje“ 2006/42/EC (17/05/06) – (9) „Elektromagnetická 
kompatibilita“ 2004/108/EC (15/12/04) – (10) „Nízké napětí“ 2006/95/EC (12/12/06) – (11) relevantní harmonizované normy: – (12) 
Jméno a funkce osoby, která prohlášení vystavila – (13) Datum: 

 
MAGYAR (HUNGARIAN) (1) CE MEGFELELİSÉGI NYILATKOZAT - (2) Mi, az: DESOUTTER - (3) kijelentjük, hogy a termék(ek) - (4) 
géptípus(ok): - hogy a termék(ek): - (5) géptípus(ok): - (6) A mőszaki leírás az EU-s - (7) megfelel(nek) a tagországok törvényeiben 
megfogalmazott, alábbiakban szereplı tanácsi Irányelvek követelményeinek: - (8) “Gépek, berendezések” 2006/42/EC (17/05/06) - (9) 
“Elektromágneses kompatibilitás” 2004/108/EC (15/12/04) - (10) “Alacsony feszültségő szabványok” 2006/95/EC (12/12/06) - (11) 
alkalmazható harmonizált szabvány(ok): - (12) Kibocsátó neve és adatai: - (13) Dátum: 
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(1)  DECLARATION OF CONFORMITY 
            (Fr) DECLARATION DE CONFORMITE 

LIETUVIŠKAI (LITHUANIAN) (1) EB ATITIKTIES DEKLARACIJA - (2) Mes: DESOUTTER - (3) Techninius duomenis galite - (4) 
pareiškiame, kad gaminys(-iai): - (5) mašinos tipas(-ai): - (6) Produkto kilmė - (7) atitinka Europos Tarybos Direktyvų reikalavimus dėl 
valstybių narių įstatymų, susijusių: - (8) su „mašinomis" 2006/42/EB (17/05/06) - (9) su „Elektromagnetiniu suderinamumu" 
2004/108/EB (15/12/04) - (10) su „Žema įtampa" 2006/95/EB (12/12/06), suderinimo - (11) taikomi harmonizuoti standartai: - (12) 
Išdavusio asmens pavardė ir pareigos: - (13) Data: 
 
SLOVENŠČINA (SLOVENIAN) (1) IZJAVA ES O SKLADNOSTI - (2) Mi: DESOUTTER - (3) Tehnična kartoteka je na voljo - (4) izjavljamo, 
da je izdelek (oziroma izdelki): - (5) vrsta stroja (oziroma vrste): - (6) Izvor izdelka - (7) v skladu z zahtevami direktiv Sveta Evrope o 
približevanju zakonodaje držav članic glede: - (8) "strojev" 2006/42/ES (17/05/06) - (9) “Elektromagnetne združljivosti” 2004/108/ES 
(15/12/04) - (10) “Nizke napetosti” 2006/95/ES (12/12/06) - (11) veljavnih harmoniziranih standardov: - (12) Ime in funkcija izdajatelja - 
(13) Datum: 
 
POLSKI (POLISH) (1) UE –DEKLARACJA ZGODNOŚCI - (2) My, firma DESOUTTER - (3) Plik techniczny jest dostępny w - (4) 
oświadczamy, ze produkt (produkty): - (5) urządzenie typu (typów): - (6) Pochodzenie produktu - (7) jest (są) zgodne z wymogami 
Dyrektywy Rady, odpowiadajacej ustawodawstwu krajów członkowskich i dotyczącej: - (8) “maszyn i urządzeń" 2006/42/UE (17/05/06) - 
(9) “Zgodności elektromagnetycznej” 2004/108/UE (15/12/04) - (10) “niskich napięć” 2006/95/UE (12/12/06) - (11) stosowanych norm, 
wzajemnie zgodnych: - (12) Nazwisko i stanowisko wydajacego deklarację: - (13) Data: 
 
SLOVENSKY (SLOVAK) (1) DEKLARÁCIA ER O SÚHLASE - (2) My: DESOUTTER - (3) Technický súbor k dispozícii z - (4) 
prehlasujeme, že výrobok (y): - (5) strojový typ(y): - (6) Pôvod produktu alebo výrobku - (7) zodpovedá požiadavkom Smerníc rady, týkajcich 
sa aproximácie zákonov členských štátov, pre: - (8) “strojné zariadenia” 2006/42/EC (17/05/06) - (9) po “Elektromagnetickú 
kompatibilitu” 2004/108/EC (15/12/04) - (10) po “Nízke napätie” 2006/95/EC (12/12/06) - (11) zodpovedajúce harmonizačné normy: - 
(12) Meno a funkcia vystavovateľa dokladu: - (13) Dátum: 
 
LATVISKI (LATVIAN) (1) EK ATBILSTĪBAS DEKLARĀCIJA - (2) Mēs, kompānija DESOUTTER - (3) Tehniskais fails pieejams ES - (4) 
deklarējam, ka šis (-ie) izstrādājums (-i): - (5) ierīces tips (-i): - (6) Izstrādājuma izcelsme - (7) atbilst Padomes Direktīvu prasībām par 
dalībvalstu likumu piemērošanu, kas attiecas uz: - (8) “mehānismiem” 2006/42/EK (17/05/06) - (9) “elektromagnētisko savietojamību” 
2004/108/EK (15/12/04) - (10) “zemspriegumu” 2006/95/EK (12/12/06) - (11) spēkā esošajam (-iem) saskaĦotajam (-iem) standartam (-
iem): - (12) Pieteicēja vārds un amats: - (13) Datums: 
 

中文 (CHINESE) (1) EC 一致性声明 - (2) 我们：DESOUTTER - (3) 技术参数资料可以从EU总部获得。 - (4) 声明其产品: - (5) 机器类型: - (6) 

产品原产地 - (7) 符合会员国立法会议“ 决定” 的相关要求: - (8) “机械” 2006/42/EC (17/05/06) - (9) “电磁相容性” 2004/108/EC (15/12/04) - 

(10) “低电压” 2006/95/EC (12/12/06) - (11) 适用协调标准: - (12) 发行者名称和地点: - (13) 日期: 

 
РУССКИЙ (RUSSIAN) (1) ДЕКЛАРАЦИЯ СООТВЕТСТВИЯ - (2) Мы: DESOUTTER - (3) Технический файл можно - (4) зявляем, что 
продукция: - (5) тип оборудования: - (6) Происхождение продукта - (7) соответствует требованиям директивы европейского совета 
относительно законодательств стран-участниц по: - (8) “Машинному оборудованию” 2006/42/EC (17/05/06) - (9) по 
“Электромагнитной совместимости” 2004/108/EC (15/12/04) - (10) по “Низкому напряжению” 2006/95/EC (12/12/06) - (11) 
применяемые согласованные нормы: - (12) Фамилия и должность составителя: - (13) Дата: 
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